TELEMED

Ultrasound Systems

3DView - PanoView

3DView - Rendering 3D Software
PanoView - Panoramic Imaging software

User Manual

Interactive Visualisation of Volume Data

InViVo ScanNT
Telemed Edition

Telemed Medical Systems web: www.telemedultrasound.com
Telemed Office mail: info@telemeditalia.com
Customer Care mail: customercare@telemeditalia.com
Telemed UAB Vilnius web: www.telemed.lt
Declaration of Conformity

The Medical Device (Class I) InViVo ScanNT 3.6 Telemed Edition meets the provision of the Medical Devices Directive 93/42/EEC. The CE marking of conformity applied to this device encompasses all other relevant Directives.
Table of contents

1. WELCOME 1-1

2. SECURITY 2-1
2.1 Security hints 2-1
2.2 Cleansing 2-2

3. TYPOGRAPHIC CONVENTIONS 3-1

4. THE 3D PRINCIPLE 4-1

5. BASIC FUNCTIONS 5-1
5.1 Start 5-1
5.2 The Operating Surface (3D Mode) 5-2
5.3 The Menu Symbol Bar (3D) 5-5
5.4 The Function Symbol Bar 5-6
5.5 Mouse Key Functions 5-8
5.6 Printing and Storage of Screen Shots 5-11
5.7 Loading of a TIFF Image 5-12

6. LOADING AND STORING OF DATASETS 6-1
6.1 Loading and Storing via Database 6-1
6.2 Loading from external storage media 6-15
6.3 Storing to external storage media 6-16
6.4 Storing the current program states 6-16

7. 3D VISUALIZATION 7-1
7.1 Illumination Model 7-2
7.2 Selection of Smoothing 7-5
7.3 Selection of Scaling 7-5

8. 3D COLOR SETTINGS 8-1

9. ULTRASOUND ACQUISITION 9-1
9.1 Acquisition of Ultrasound Sequences 9-1
9.2 Displaying the Ultrasound Sequence 9-2
9.3 Resampling of Ultrasound Acquisition Sequences 9-4
9.4 Loading and Storing of Image Sequences 9-5

10. CLIPPING 10-1
10.1 Clipping of Surface and Volume Areas 10-1
10.2 Visualization of an Oblique Cut 10-3

11. VIDEO RECORDER 11-1
11.1 Performing Rotations 11-1
11.2 Recording a Video Sequence 11-2
11.3 Displaying Animations 11-3
11.4 Loading and Storing Animations 11-4

12. TOOLS 12-1
12.1 Presets 12-3

13. THE VPAN MODULE 13-1
13.1 The VPan Menu Bar 13-2
13.2 The VPan Main Menu 13-3
13.3 Mouse Functions within the VPan Window 13-5

14. THE EASY VOLUME MODULE 14-1
14.1 The Easy Volume Menu Bar 14-1
14.2 The Easy Volume Main Menu 14-2

15. VERSION 15-1

16. DATABASE APPLICATION NOTES 16-1
16.1 How do I create a new patient? 16-1
16.2 How do I create a new user for the database? 16-2
16.3 How do I swap out data? 16-4
16.4 How do I move back a study to the main directory? 16-7
16.5 How do I import and export data? 16-8
16.6 How do I acquire frames and store in the database? 16-12

17. FAULT TRACING 17-1
17.1 Fault examples 17-1

18. SYSTEM REQUIREMENTS 18-1
18.1 Software Requirements 18-1
18.2 Hardware Requirements 18-1
1. Welcome

UAB “Telemed” and MedCom GmbH is pleased to present to you the InViVo ScanNT Telemed Edition program, a product coming up to the latest requirements of medical diagnostics.

**Intended Purpose**

- **InViVo ScanNT Telemed Edition**: extends with its innovative program functionality the display of two-dimensional ultrasound images, thus facilitating interpretation of diagnostic records.

- **InViVo ScanNT Telemed Edition**: allows a three-dimensional presentation of acquired two-dimensional ultrasound images and a removal of volume areas in the three-dimensional display of the object.

- **InViVo ScanNT Telemed Edition**: allows a combination of ultrasound images into a larger VPan image in order to increase the ultrasound image size.

- **InViVo ScanNT Telemed Edition**: additionally realizes video animations of the three-dimensional object generated and visualized by the program by ultrasound acquisition or selected with an external storage medium.

- **InViVo ScanNT Telemed Edition**: with its functionality is especially applicable in the medical fields of gynecology and obstetrics as well as internal medicine, urology, cardiology, surgery and orthopedics.

- **InViVo ScanNT Telemed Edition**: may be operated by practitioners and medical personnel instructed by authorized persons.

- **InViVo ScanNT Telemed Edition**: is linked to a MS-SQL database for the filing of datasets.

We wish you good results with the application of InViVo ScanNT Telemed Edition.
2. Security

2.1 Security hints

**WARNING**

signifies a possibly dangerous situation. If ignored, it can result in a serious injury or a permanent harm.

**ATTENTION**

It is not admitted to ground a diagnosis just on the results of InViVo ScanNT Telemed Edition. MedCom is not engaging in any responsibility for indirect harms due to the use and evaluation of diagnosis data furnished by InViVo ScanNT Telemed Edition.

**WARNINGS:**

Repeat the acquisition when images are noisy

If at high-contrast image sections - especially at the transition of tissues - the three-dimensional presentation of an object is noisy it is recommended to repeat the acquisition. Please check again that no electrically driven devices are within the acquisition reach.

Optical delusion

The presentations under the main menus 3D-RENDER and RECORDER as well as the orientation image are projections. This kind of presentation can have optical delusion effects similar to those experienced when regarding a line model of a cube. The orientation of a structure (out of a frame or into a frame) can - due to the human optical perception - not be clearly viewed and is changing (shifting/skipping) when viewed for a longer time. The generation of a moving animation gives a more unmistakable presentation where the spatial depth of the image can be easily discerned.

Requirements to the ultrasound device

The acquisition may be performed only in connection with the software that’s steering the EchoBlaster ultrasound device. Please see the Telemed’s manuals for more details.
2.2 Cleansing

Dirty ultrasound gel and bacteria on the ultrasound probe and are a possible infection risk. Please do periodically clean these parts including the cable with the cleaning agent recommended by the probe manufacturer.
3. Typographic Conventions

The following notations help to identify special information in the text.

<table>
<thead>
<tr>
<th>Type face</th>
<th>Signification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bold in the margin</td>
<td>Menus in the menu instruction bar (InViVo ScanNT <em>Telemed Edition</em> working surface and that of the database)</td>
</tr>
<tr>
<td>Bold in text</td>
<td>English and German software terms. German terms when mentioned first</td>
</tr>
<tr>
<td>Bold in text and /</td>
<td>The English software terms are segregated from the German translation by a slash when mentioned first.</td>
</tr>
<tr>
<td>SMALL CAPITAL</td>
<td>Designation of main menus</td>
</tr>
<tr>
<td>CAPITAL LETTERS</td>
<td>Designation of certain datasets</td>
</tr>
<tr>
<td>“ ”</td>
<td>References to chapters are in inverted commas.</td>
</tr>
<tr>
<td>&lt;XX&gt;</td>
<td>The key identification for activating the dialog areas of the main menus are in brackets.</td>
</tr>
</tbody>
</table>
4. The 3D Principle

The EchoBlaster ultrasound device is linked to a standard PC by the USB cable. During the ultrasound acquisition all images from the ultrasound device in the B mode are transferred to the PC via the USB 2.0 interface and saved in the main memory of the PC. The EchoWave application combines ScanNT Telemed Edition and the EchoBlaster ultrasound device into one system.

The digitized sequences of the images are, together with their calculated position and orientation data, converted to a volume dataset and stereoscopically displayed by one of the multiple methods of 3D visualization.
## 5. Basic Functions

### 5.1 Start

**Startup**

The ScanNT *Telemed Edition* starts either automatically (run from the EchoWave application) or can be executed as a standalone program. When started from EchoWave, it remains minimized until a respective command from EchoWave is sent. For details please refer to Telemed’s manuals. Please note, that standalone execution allows only reviewing acquired data. No acquisition without EchoWave is possible.

**Dongle**

This software is dongle protected – please make sure that the dongle is connected to the parallel port when using this software.

*Please Note:*

Your particular system may not include all functionality described in this manual. In particular, the VPan module is optional and therefore may not be included in your configuration. Please contact your customer support for further information.
5.2 The Operating Surface (3D Mode)

Figure 5-1: The operating surface

Figure 5-2: Section of the operating surface after activating a section window
A  Header line

The **Header line** shows information about the actual volume-dataset.

B  Size

After activating the 3D window the open list **Size** is called. By making your choice from 50 (smallest size) to 1000 (full size) you determine the size of the 3D window.

**WARNING**

The image size of the 3D window and the scanning rate of the volume dataset must be in a sensible relation to each other so that after determining the image size an optimal display quality of the 3D object is achieved.

C  Slice

After activating a section window the regulator **Slice** is called which serves to choose the slices of an orthogonal level. On the left side of the regulator the present position of the slice in the orthogonal level is shown.

D  Zoom

By the regulator **Zoom** the size of the object in the three section windows and in the 3D window is smoothly adjusted.

**WARNING**

By strongly reducing or enlarging with the regulator **Zoom** an insufficient image quality can be the result.

E  Warning symbol

The **Warning symbol** indicates that the user has performed an action entailing that essential information is possibly no longer noticeable. This can involve wrong deductions at the evaluation of the data. By clicking the Warning symbol you get help (**Warning**) as to which action has caused the warning.

![Warning](image)

**Figure 5-3: Warning**

This warning appears under the following actions:
- Activated smoothing of the display
- Removed areas under **Clipping Mode**
- Swapped ultrasound orientation during acquisition

This warning must especially be considered with the patient datasets that are reloaded into the main menu from the database.
F  Grey shade bar  
By the Grey scale bar the contrast and intensity refining of the sections in the section windows is done.

G  Menu icon bar  
By the buttons of the menu icon bar the main menus of InViVo ScanNT Telemed Edition are invoked. After selecting a main menu the dialog field (M) appears on the right bottom side of the surface by which the main functions are performed.

H  Function icon bar  
by the buttons of the Function icon bar functions are invoked which help to perform actions in the section windows and the 3D window.

I Section image window  
In the three Section image windows section images of an object are shown in the orthogonal section plane. The section images acquired by ultrasound are in the basic layout positioned in the middle of the section image window. The variable red inner frame surrounds the region of interest. The windows are bordered by a colored outer frame with a scale. After activating a section image window a broad outer frame appears. The frames of the section image windows coincide with the three planes of the space coordinates shown in the 3D orientation window. The colored outer frames of the section image windows and the corresponding frames of the orthogonal planes in the 3D orientation window allow an optical and spatial classification. The two colored arrows positioned left and above indicate the position of the other two orthogonal planes. Areas outside the volume are shown in a lighter shade.

K 3D window  
In the 3D window a three dimensional display of the acquired object is shown after the sampling of the section images. By defining modes and functions of the main menus modifications of the objects can be made. The 3D window has no outer frame with a scale. Areas outside the volume are shown in a lighter shade.

L 3D orientation window  
In the 3D orientation window the three orthogonal section planes are shown in their spatial orientation to each other (3D orientation image). The yellow, green and blue border allows the classification between the section image windows and the 3D orientation window. Rotations of the object can be viewed simultaneously in the 3D orientation window and in the 3D window. A gliding through the section planes (by the regulator Slice) is performed synchronously in the 3D orientation window and in the section image windows. The position of the ultrasound acquisition is marked at the 3D orientation image by a light-blue orientation line showing the starting point of the acquisition S and the final point of the acquisition E. On rotation of the 3D orientation image the position of the orientation line changes respectively.

WARNING
See hint for „Optical delusion“ in the chapter „Security hints“.
Basic Functions

| M  | Dialog field | On the **Dialog field** the respective modes and functions of the main menus of InViVo ScanNT **Telemed Edition** are identified. |
| N  | Status bar   | The **Status bar** shows on the left side information about the actual main menu. On the right side the coordinates of a window where the mouse is located are indicated. |
| O  | Presets      | Using the **Presets** you may load predefined parameter settings and/or defined your own presets. |
| P  | 3D / VPan / EasyVolume | Using these buttons you select the main software mode:  
a) 3D Mode for 3D Ultrasound processing  
b) VPan mode for generating larger Ultrasound Images.  
c) Easy Volume mode for fast recording a sequence of 3D datasets  
Note: These options may not be included in your System Setting. |

5.3 The Menu Symbol Bar (3D)

On the buttons of the menu symbol bar the main menus of InViVo ScanNT **Telemed Edition** are activated.

**Loading and Storage of Datasets**
In the main menu **FILE I/O / Loading and Storage of Datasets** the loading and storage of volume datasets is done.

**3D Visualization**
In the main menu **3D RENDER / 3D Visualization** the InViVo ScanNT **Telemed Edition** performs a transparency representation and a surface reconstruction.

**Ultrasound Acquisition**
In the main menu **ACQUISITION / Ultrasound Acquisition** ultrasound acquisition sequences are acquired. After acquiring ultrasound images (Scanning or Sampling) a three-dimensional real reconstruction of anatomic relations (Resampling) is achieved by combining the two-dimensional single images.

**Clipping**
In the main menu **Clipping** surface and volume areas of the object are clipped out of the section image windows and in the 3D window and deleted.

**Video Records**
In the main menu **Recorder** video sequences (animations) of rotations of the object to be examined are recorded, loaded and saved.

**Color Parameter**
<table>
<thead>
<tr>
<th><strong>InViVo ScanNT Telemed Edition</strong></th>
<th><strong>Basic Functions</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>In the main menu <strong>COLOR</strong> the parameter which are specific for the 3D display of color data are specified.</td>
<td></td>
</tr>
</tbody>
</table>

**TOOLS**
In the main menu **TOOLS** the distribution of the grey values of the datasets are identified.

**PRESETs**
In the presets Dialog predefined and user defined application settings can be selected.

**VERSION**
In the main menu **VERSION** the address of the supplier and the version number of InViVo ScanNT Telemed Edition are shown.

### 5.4 The Function Symbol Bar

By activating the 3D window or one of the section image windows two function symbol bars with a differing number of buttons are activated according to the window type.

#### 5.4.1 The Function Symbol Bar of the 3D Window

<table>
<thead>
<tr>
<th><strong>Full-page image</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Save screenshot of 3D window in the database, on file system or send to the printer.</strong></td>
</tr>
<tr>
<td><strong>Axis-parallel section</strong></td>
</tr>
<tr>
<td><strong>Light source</strong></td>
</tr>
<tr>
<td><strong>Draw slice lines in 3D window</strong></td>
</tr>
<tr>
<td><strong>Change the 3D display mode from Volume Display to a Slice Display.</strong></td>
</tr>
</tbody>
</table>

#### 5.4.2 The Function Symbol Bar of the Section Window

| **Full-page image** |
Basic Functions

InViVo ScanNT Telemed Edition

Save screenshot of active section window in the database, on file system, CD, or send to printer.

Automatic sliding through the orthogonal section plane

Eliminate 2D section window offset, i.e. centres the image.

5.4.3 The Function Symbol Bar in Menu-specific Windows

In the menu-specific windows additional buttons are activated. The function symbol bars of menu-specific windows are presented in the respective main menus.

Enlarge image i.e. Zoom in (window: Ultrasound image, window: Animation, Window: Histogram)

Reduce image i.e. Zoom out (window: Ultrasound image, window: Animation, Window: Histogram)

Activate the indication of the oblique cuts in the 3D window (window: Oblique Cut)

Changing Trigger Mode (window: Oblique cut)

Display Cut-Lines in the section windows (window: Oblique cut)

Indication of grey shade (Window: Histogram)

Close the window (window: Histogram, window: TIFF image, window: Oblique cut)

Show frames as thumbnails (window: Ultrasound image)

Undelete all frames (window: Ultrasound image)

Creation of an AVI file of the acquired video images (window: Ultrasound image)

One picture back (window: Animation)

Stop the running video sequence (window: Animation)
Play the video sequence (window: Animation)

One picture forward (window: Animation)

Switch to alternating direction rotation (window: Animation)

Switch to one-direction rotation (window: Animation)

### 5.5 Mouse Key Functions

The ScanNT Telemed Edition program allows activating a great number of functions by mouse keys. The ScanNT software has been designed for use with a 3 button mouse, however if there's no middle button available, one can invoke its functions by an \textit{ALT + left click} combination.

#### 5.5.1 Mouse key functions for the 3D window

<table>
<thead>
<tr>
<th>Function</th>
<th>Action with the mouse</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Light source</td>
<td>Push simultaneously</td>
<td>New X/Y position</td>
</tr>
<tr>
<td></td>
<td>Shift + left mouse key</td>
<td>and move mouse.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Push simultaneously</td>
<td>New Z position</td>
</tr>
<tr>
<td></td>
<td>Control + left mouse</td>
<td></td>
</tr>
<tr>
<td></td>
<td>key and move mouse.</td>
<td></td>
</tr>
<tr>
<td>Axis-parallel</td>
<td>Push left, middle or</td>
<td>The respective section is done in the 3D window.</td>
</tr>
<tr>
<td>section</td>
<td>right mouse key</td>
<td></td>
</tr>
<tr>
<td></td>
<td>.</td>
<td>The section is shown and marked in the section window.</td>
</tr>
<tr>
<td>Eraser (only for 3D Surface)</td>
<td>Push left mouse key</td>
<td>Selection of the area to be erased</td>
</tr>
<tr>
<td></td>
<td>Push middle mouse key,</td>
<td>Perform one erasing step</td>
</tr>
<tr>
<td></td>
<td>Push right mouse key</td>
<td>Canceling the last erasing action</td>
</tr>
</tbody>
</table>
## Basic Functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Mouse Key Functions</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Free erasing</strong></td>
<td>Push left mouse key, move mouse  Fixing the contour line</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Push middle mouse key, Fixing the contour line</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Push right mouse key, Deletion of the inside areas</td>
<td></td>
</tr>
<tr>
<td><strong>Include Area</strong></td>
<td>Push left mouse key, Fixing the contour line</td>
<td></td>
</tr>
<tr>
<td><strong>(Erase Outside)</strong></td>
<td>Push middle mouse key, Fixing the contour line</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Push right mouse key, Deletion of parts outside this area</td>
<td></td>
</tr>
</tbody>
</table>

### 5.5.2 Mouse key functions for the 3D orientation window

<table>
<thead>
<tr>
<th>Function</th>
<th>Mouse Key Functions</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Rotation of the 3D coordinate frame</strong></td>
<td>Push left resp. right mouse key and move mouse</td>
<td>Rotation of the 3D coordinate frame</td>
</tr>
</tbody>
</table>

### 5.5.3 Mouse key functions for the section window

<table>
<thead>
<tr>
<th>Function</th>
<th>Mouse Key Functions</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Move Clipping Polygon</strong></td>
<td>Click angle of polygon with left, middle or right mouse key and move mouse</td>
<td>Changing the clipping area by shifting the angles of the polygon</td>
</tr>
<tr>
<td><strong>Free erasing</strong></td>
<td>Push left mouse key, move mouse  Fixing the contour line</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Push middle mouse key, Fixing the contour line</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Push right mouse key, Deletion of the inside areas</td>
<td></td>
</tr>
<tr>
<td><strong>Include Area</strong></td>
<td>Push left mouse key, Fixing the contour line</td>
<td></td>
</tr>
<tr>
<td><strong>(Erase Outside)</strong></td>
<td>Push middle mouse key, Fixing the contour line</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Push right mouse key, Deletion of parts outside this area</td>
<td></td>
</tr>
</tbody>
</table>

### 5.5.4 Mouse key functions for the Oblique Cut window

<table>
<thead>
<tr>
<th>Function</th>
<th>Mouse Key Functions</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>(Window Trigger)</strong></td>
<td>Push left mouse key and move mouse</td>
<td>Shifting the plane of the oblique cut</td>
</tr>
</tbody>
</table>
### 5.5.5 Mouse key functions for the grey shade bar

<table>
<thead>
<tr>
<th>Mouse key actions</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Push left mouse key and move mouse</td>
<td>Movement of the histogram regulator and move mouse next to the cursor</td>
</tr>
<tr>
<td>Push middle mouse key and move mouse</td>
<td>Movement and stretching of the histogram inside the grey bar</td>
</tr>
<tr>
<td>Push right mouse key and move mouse</td>
<td>Restoring of the histogram (intensity 1.0; contrast 0.0)</td>
</tr>
</tbody>
</table>

### 5.5.6 Mouse key functions for the Histogram window

<table>
<thead>
<tr>
<th>Mouse key actions</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click with left mouse key into the histogram and move mouse</td>
<td>The selected grey shades are faded into the histogram and in on top of the histogram in red letters</td>
</tr>
<tr>
<td>Click with middle mouse key a certain grey shade in the histogram</td>
<td>All areas of the same grey shade are marked in the sections of the section windows in green color. In the grey shade bar of the histogram the resp. grey shades are marked by a red line. The shades are faded in on top of the histogram in the indication</td>
</tr>
<tr>
<td>Click with left and right mouse key two grey shades in the histogram to determine a grey shade area</td>
<td>All grey shades of the grey shade area are marked yellow in the sections of the section window. The grey shade area is marked by a pink and red line in the grey shade bar of the histogram.</td>
</tr>
</tbody>
</table>
5.6 Printing and Storage of Screen Shots

In the centre windows (i.e. the 3D Window and the Slice Windows) the window content can be stored or printed using the *Photo* button. After pressing this button the following dialog box appears:

![Screen Shot Options](image)

**Figure 5-4: Image Output Options**

Using the *Layout* options you define whether the single window should be exported or all 4 Windows in the centre area are captured. Using the *Destination* option you specify if the image should be stored in a file (Using JPG format), stored in the Database or that the image should be sent to a printer.

In the remaining output windows like the *Oblique Cut* window the image export output function is selected using either the *Photo* button or the *Printer* button.

If you select in the print option, the *Print Image* mask is activated. The printing is activated by clicking *OK*. The window image belonging to this selection is then printed.

![Print Image](image)

**Figure 5-5: Print Image dialog box**

Under *Number of copies* you enter the number of copies

Note: The database option is not available if the currently loaded 3D dataset does not yet exists inside the database.
5.7 Loading of a TIFF Image

A TIFF image is loaded using the database (see chapter „Loading and Storing via Database“). After selecting a patient dataset you load a TIFF image by double clicking on the appropriate TIFF entry. ScanNT Telemed Edition opens a separate window to display the TIFF image (see Figure 5-6).

Figure 5-6: Window: TIFF-Viewer
6. Loading and Storing of Datasets

In the main menu **FILE I/O** the loading and storing of patient datasets (volume datasets) is executed.

The main menu **FILE I/O** is activated by clicking the resp. field in the menu symbol bar.

![FILE I/O](image)

**Figure 6-1: Dialog field File I/O**

6.1 Loading and Storing via Database

By **Open Patient Database** the database is activated. Here the patient datasets are saved and loaded. Also the administration, the input and the selection of patient data and the selection of examinations of a patient are performed here. After clicking the button you activate the surface of the database (Fig. 6-2) and you may select a dataset from the database.

To load a patient database you first select a patient from the **List of Patients** and double click on one the related data in the **List Of Data**. During the loading process the dialog **Working Dialog** indicates that ScanNT *Telemed Edition* is performing the process.

By **Save 3D to Database** patient datasets (volume datasets) are saved. The button is only active if two-dimensional ultrasound pictures are newly reconstructed to a three-dimensional dataset (see: Resampling in Ultrasound Acquisition) or a 3D dataset has been imported. A detailed description of the storing process of animations, pictures, or picture sequences is given in the respective main menus.
Login

At the first use of the database at each session, a login dialog appears.

![Login Dialog Box](image)

Figure 6-2: Login Dialog Box

After selecting the current user in the list **Doctor**, type the password and press **OK** to log in to the database. Note, that a password is not necessarily required.

After you’ve logged into the database the main window of the database appears:

![Database User Interface](image)

Figure 6-3: Database User Interface

The database UI consists of the toolbar, the List of Patients, the List of Study Data and the Data preview filed. The several options provided by the database are described as follows.
Loading and Storing of Datasets

All files will be stored per default in a directory on the local computer’s hard disc. This directory is defined as the **Main Dir**. Moreover the program gives the opportunity to define directories for long term data storage, especially to avoid a full **Main Dir**. These directories will be defined under the menu item **Administration -> Drives** (see description on the following pages). After you have selected **Swap Out Data** the dialog shown in Figure 4-4 appears.

![Swap Harddisk Data](image)

**Figure 6-4: Swap Data Dialog Box**

Here you can define which part of the data you want to swap out and to which location you will move it. If you check **Move all studies older than**... only studies of an age older than x months are swapped out. The field below gives you the opportunity to restrict the amount of data you want to swap out. So you can define e.g. that not more than 650 MB shall be swapped out. In the list box at the button you select the directory to which you want to swap out data. This could be on the local hard disc, another computer in the local network, an MO-drive (or, in the future, also a CD-Rom.)

By pressing this button the database terminates and the main ScanNT window will be reactivated.

The **Logout** button is used to change the current database user. This is useful when you are leaving the office and/or finishing your daily work and you want to lock any other person from your data.

After selecting the **New patient** button a new patient record can be generated.
List Of Patients

In this field all patients that are related to the current user are displayed. To select a patient simply click with the left mouse button the patient name. When performing a double click the list of examinations will be opened. When selecting a particular examination date the corresponding data items will be displayed – when clicking on the patient name all data that is related to the patient is displayed in the data list.

List of Study Data

Using this list a particular data entry is selected. After selecting the entry the appropriate data information is displayed in the Data Information field. Double clicking on the data entry performs loading of data into ScanNT.

Preview Image

Every time a new file is stored into the database a Preview Image is generated automatically and assigned to the new database entry. In case you want to change the preview image for an Volume Dataset you may store the Configuration for this Dataset again while selecting the button “Overwrite the Default Dataset Configuration”:

6.1.1 Database Menu Options

Although the functions of the database program are selected mainly in the main window some options are selectable via menu entries.

File

The File menu gives the opportunity to:

- **Swap Out Data** from the temporary data directory, where the files are stored by default to an external media or to another drive.
- **Import Data** from other databases. To be able to do this the data must be exported by another MedCom database before (see Chapter 16).
- **Logout** from the current Server or local database.
- Switch from the **Client** mode back to the **MainApp (Back to Main Application)**.
Chapter 16 describes how you can export data from any MedCom database to a file with the format mcd. If you select the menu item **Import Data** you can select such a file. Then the data stored in that file will be imported to the database you are logged in at the moment.

If you select **Logout**, the connection to the Server or to the local database you are connected to, will be closed. The login window appears again and you will be forced to login again.

If you select this option, you will switch back from the Client's interface to the interface of the **MainApp**.

In the menu **Add** you can add a new patient data entry to the database or import DICOM files (currently not supported by ScanNT Telemed Edition).

When selecting the New Patient button in the database main window or when storing data the dialog box for setting patient information appears on the screen (Figure 6-5).

By filling the corresponding fields the patient information can be specified. Please consider that the Optional Fields may not be initialized in your current application. Please refer to the description in the next chapter for setting the optional fields. The birthday can be set using the calendar control.

The Medical History Field which could be used also for comments is restricted to 250 characters at this moment.
The Administration Menu

The Administration menu gives the opportunity to:

- Change the view of the Client’s GUI with View.
- Reduce the number of patients shown in the patient view over Filter Patients.
- Create, modify and delete user data and access rights functions over the User Manager.
- Change the settings for the Status Bar.
- Create and modify the directories for swapping out data with Drives.
- Changing settings for the network connections and the DICOM I/O over the menu item Network.

View

With View->Icon Bar you can make the icon bar visible or invisible and with View->Statusbar, you can do the same for the Status Bar.

Filter Patients

If you select Filter Patients you can define a filter for the patient-tree. This means you can reduce the number of the patients visible in the tree according to the following characteristics:

- Patient ID
- First name of the patient.
- Last name of the patient.
- Data Age (younger than one month, younger than 3 month, etc.)
The example in figure 6-6 shows a filter that reduces the visible patients to all patients whose first name starts with an R and whose last name starts with an O.

User Manager

The purpose of the User Manager is to add and change users, respectively doctors, and to create and modify user groups (functions) which specify the rights of a user.
InViVo ScanNT Telemed Edition

**Loading and Storing of Datasets**

**Doctors->New, Edit**

To add a new user you press **New**. To change a user you may select the user and press **Edit** or double-click on the user. In both cases the dialog box shown in Figure 6-8 appears which is used to define the properties of a user. In principal the term “users” here has two different meanings:

a) users of the database

b) communication partners with whom you interact through the sending and receiving of messages (only in the tele-versions of the software)

For a communication partner you need to select a phonebook entry, but do not enter values in the field **Database Access**, unless you want that this external user has access right to your data.

The demographic data is used to give you detailed information about a user and to be sent with a message to a remote communication partner, so that he has identifying information about the sender of a message.

![Figure 6-8: Editing the User-Information](image)

Using **Function** you assign a user to a function with specific access rights.

**Doctors->Delete**

By pressing **Delete** you remove the selected user from the database.

**Functions->New, Edit**

If you want to create a new class of User-Functions you may press **New**. If you want to change a Function-Class you may select the entry and press **Edit** or double-click on the function. In both cases the dialog box **Edit Function** (Figure 6-9) appears.
Here you select out of a list of access rights that you want to assign to this user group. The access rights are the following:

- **Edit Users**: Change the properties of a user.
- **Create Users**: Create a new user.
- **Delete Users**: Delete users.
- **User DB Access**: Change the database access properties of a user.
- **Modify Functions**: Create, modify and delete functions.
- **Network Settings**: Modify the Network settings.
- **Save to disc**: Swap out data.
- **Patients**: Create, modify and delete patients.
- **Optional fields**: Modify the optional fields settings.
- **Settings**: Has no meaning in this version of the software.
- **Dicom I/O**: Use of DICOM Import.
- **Access all Patients**: See also the patients of other users.

Moreover you need to give the user group a name.

**Functions->Delete**

Delete the selected function.

**Optional Fields**

After selecting the **Optional Fields** entry the dialog for specifying the patient data fields appears (Figure 6-10):
By setting **Name** the title of the optional field is specified. Press **Add**, **Edit** or **Delete** to set the entries for this optional field.

**WARNING:**

Setting these fields alters every previously stored patient information since they all share these optional fields.

**CAUTION**

It is recommended to define the names of the optional fields once. And afterwards only add elements to the list.

**Status Bar**

In the **Statusbar** dialog (Figure 6-11) you define, depending on the free space of your main directory, when a warning message and when an error message shall appear. For example, a warning message appears, when there is less than 500 MB and an error message appears, when there is less than 80 MB free on the hard disc, on which your main directory is located.
Drives

The dialog **Drives** (Figure 6-12) gives you the opportunity to change the path to the main directory, this means the path where your data will be stored by default, and to define other directories on hard disc, MO, network-drives and in the future CD-Rom-drives, where you can swap out data to.

![Figure 6-12: Dialog Drives](image)

### Add

Select this button if you want to create a new directory for swapping out your data. Figure 6-13 shows the **Add Drive** dialog. To create a new directory, browse for the path to the directory using **Browse for Data-Path** or enter the path directly in the edit field. Then select the drive type and optionally enter a comment for the directory. If all settings are correct the program creates a new directory. If you enter a path for an existing drive, which doesn’t already exist, the program will create it.

![Figure 6-13: Add Drive dialog](image)

### Delete

Delete the data storage directory. You cannot delete a directory on which data is stored.

### Modify

If you select a directory and press this button the **Modify Drive** (Figure 6-14) dialog appears. Here you can change the path and comment for a defined directory.
In the **Network Settings** (Figure 6-15) dialog you define several values for the DICOM functionality and timeouts for the network communication (Note: Dicom and Client Server Version may not be included in your software version).

**General**

In the **General** area you can define five values which are used for the DICOM I/O:

- **Default IP address**: Default target IP address for DICOM operations.
- **Default DICOM Port**: Default port for DICOM operations.
- **use little-endian**: Use little endian for encoding or not.
- **Own AE title**: AE title for the sender.
- **Target AE title**: AE title for the target.

**Timeout**

In the **Timeout** area you define four timeout values which are used for the network connections between the **Client** and the **Server**:

- **General Timeout**: Timeout for every operation between the Client and the Server, which is not covered through the other timeout values.
- **Timeout while Login**: Timeout after which the login operation will be aborted.
- **Timeout for DICOM-Operations**: Timeout after which DICOM operations will be aborted.
- **Automatic Logout from the Server after**: If no operation takes place the connection will be closed after this time. This applies only for RAS (Modem or ISDN) – connections.

**Note**: These options are not required for ScanNT **Telemed Edition**.
6.1.2 Pop-Up Menus inside the Database

The Database user interface has three different pop-up menus. If you click the right mouse button on a patient in the patient-tree, you will see the **Patient Pop-Up menu**. If you click the right mouse button on a study you will see the **Study Pop-Up menu** and if you click the right mouse button on a file in the data tree, you will see the **File Pop-Up menu**.

**The Patient Pop-Up Menu**

The picture on the left shows the **Patient Pop-Up menu**. If you select **New**, the dialog to create a new patient appears. If you select **Edit** you can modify the properties of the patient you have selected, thereby the dialog will be the same as when creating a new patient. If you select **Delete**, the patient and all corresponding studies and files will be deleted.

If you select **Swap out to**, all data which belongs to the patient will be moved to an external media. A dialog appears which allows you to select the directory where you want to swap out the data to (Figure 6-16). Swapping out data is only possible, if you are logged in the local database.

![Figure 6-15: Network Settings Dialog](Image)

**Figure 6-15: Network Settings Dialog**

![Figure 6-16: Select Directory for swap out](Image)

**Figure 6-16: Select Directory for swap out**
InViVo ScanNT Telemed Edition

Loading and Storing of Datasets

If you want to create a new study for a patient, please select **New Study**. Then you will be asked to enter a description for the new study. After you have created the study, you can store files as part of this study.

**Export to file** is used to export your patient data to a file (see chapter 16 for details).

To filter the patient list after certain criteria please select **Filter Patient view**. The filter patients dialog appears.

If you select **Logout...**, the login window appears again and you can re-login to your database or another database server.

The Study Pop-Up Menu

The **Study Pop-Up menu** as shown on the left is used to perform several actions on a study.

With **Edit...** you can change the description of a study. With **Delete...** you can delete the study and all files belonging to this study.

If you select **Swap out to**, all data that belong to the study will be moved to an external media. A dialog appears which allows you to select the directory where you want to swap out the data to (Figure 6-16). Swapping out data is only possible, if you are logged in the local database.

If you are logged in a local database, you will have the option **Upload to a server**. If you are logged in a server you will have the option **Copy to local DB** instead. With these options you can move a study and the corresponding file and patient information from the local database on your PC to a server database and vice versa (Server Database not included SscanNT Telemed Edition).

**Export to file** is used to export your study data to a file (see chapter 16 for details).

**Logout...** again is used to logout from the database and re-connect to another **Server**.

The File Pop-Up Menu

The **File Pop-Up menu** is shown on the left. Use **Edit Comment...** to change the comment of a file and **Delete...** to delete the file information from the database and the file from the hard disc. **Export** is used to export your file from the database (see chapter 9.5 for details).
6.2 Loading from external storage media

In the menu field **Import** datasets of patients are loaded from the hard disk of the computer or other external storage media (CD-ROM, floppy disk).

By **3D Data Type** 3D data format types for the import of volume datasets are selected. You have the choice of the following two formats in the Menu.

- **InViVo-Vol**: The data format *InViVo-Vol* is a data format which has been specifically developed for *ScanNT Telemed Edition*.
- **Slices**: The data format *Slices* enables to import files in raw data.

By **Import 3D** the patient datasets are activated after selection of a 3D data format from the hard disk of the computer or other storage media (CD-ROM, disk).

Loading the datasets in the data format *InViVo-Vol*:

After the selection of the data format *InViVo-Vol* you activate the file manager **Open** by clicking the **3D** button.

![Figure 6-17: File Manager Open](image)

By the file manager **Open** you activate the patient datasets on the hard disk or the MO disk.

**Look in**

Under **Look in** the term of the data level is indicated.

- **A**: By clicking this button the file is put on a higher storage level.
- **B**: With this button a new directory is opened.
File list 
Here the files of the file layers are shown.

File name 
Under **File name** you insert the name of the dataset you want to load.

Files of type 
Under **Files of type** the data type is selected.

Open as read-only 
By clicking the option **Open as read-only** the saved files are just opened. No changes possible.

Open 
Under **Open** the selected dataset is loaded.

### 6.3 Storing to external storage media

Using **Export 3D** the patient datasets (volume datasets) are stored as VOL3 datasets. After calling this function you select in the file manager **Save Volume** the storage area where the volume dataset shall be stored. Fill in the file name and click the button **Store**.

### 6.4 Storing the current program states

**Configuration** 
In the menu field **Configuration** datasets with the actual parameter setting (e.g. regulator positions, polygon settings) are loaded or stored as batch files. After altering the parameter settings in a loaded batch file the original parameter settings are reset by activating the original batch file.

By clicking **Import** batch files are loaded. The file manager **Open** is called. You select and load a batch file.

By clicking **Export** the actual parameter setting is saved as a batch file. You activate the input mask **Save Batch File as**.

By clicking **Save to DB** the actual parameter setting is saved as a batch in the database.

By clicking the function key **EXIT InViVo** you leave the ScanNT **Telemed Edition** program.
7. 3D Visualization

The rendering size can be determined in the header line when a rendering window is active. Resolutions of 50² to 1000² pixels are supported.

---

**WARNING**

If the rendering size selected is too small it may happen that some pixels are no longer visible. In this case the predetermined parameter is perhaps not adequate enough so that the user must manually intervene for a visualization of important image areas.

---

In the main menu **3D RENDER** the ScanNT *Telemed Edition* system performs an X-ray simulation and a surface reconstruction. The main menu **3D RENDER** is activated by clicking the area in the menu symbol bar.

---

**Figure 7-1: 3D RENDER Dialog field**
7.1 Illumination Model

In the menu field **Illumination** mode for transparent display and surface reconstruction are determined, describing the exact calculation of the pixel values as grey shade values. These calculations are done step by step following a virtual ray. Select the desired mode in the foldout list.

![Illumination Menu](Image)

**WARNING**

See „Optical delusion“ in chapter „Security hints“.

**Minimum Value (MINIP)**

For the **Minimum Value (MINIP)** mode the minimum grey shade value along a virtual ray is calculated. This mode serves to visualize the minimum pixel grey shade following the line of sight. For ultrasound data areas with low sound reflection can be visualized.

![Minimum Value Example](Image)

**Figure 7-2: Example for MinIP**

**Maximum Value (MAXIP)**

For the **Maximum Value (MAXIP)** mode the maximum grey shade value along a virtual ray is calculated. This mode serves to visualize the maximum grey shade value in the line of sight. For ultrasound data areas with high sound reflection can be visualized.
WARNING
A wrong selection of the parameter for contrast and light intensity for the mode MINIP, MAXIP, and Absorption X-ray may lead to missing or inadequately displayed image parts. The pre-setting of values for contrast and intensity may be insufficient for a current patient dataset so that the user must manually intervene for a display of important data fields.

Gradient

For the **Gradient** mode the grey shade gradients and opaque structures are used for the calculation of the surface. Along a virtual ray opaque structures are used as weighting factors.

The **Gradient** mode is well suited for poorly defined surfaces, e.g. for ultrasound acquisition. The more the modification tendency increases about the grey shade the bigger is the area which is included for the surface calculation.
WARNING

A wrong parameter selection for the surface visualization may entail that important parts of the picture are not visualized. The predefined parameter could not suffice for the actual case so that the user must manually intervene for a visualization of important parts of the picture.

Semi Transparent

For the **Semi Transparent** mode grey shades along a virtual ray are summed up. Semi-transparent and opaque structures are visualized.
For the Semi Transparent mode all darker grey shades lying to the left of a selected mean value are discriminated when choosing Mean Value (see below) regulator, however, all lighter grey shades lying to the right of the mean value are included in the calculation.

Mean Value

In order to adjust the threshold value for the surface use the regulators Mean Value and Tolerance under the open list. The tolerance indicates how exact the threshold value influences the surface extraction. For very small tolerance values InViVo-ScanNT Telemed Edition calculates surfaces with the same shade (ISO surfaces).

Contrast

In order to set contrast and light intensity for the surface and volume modes, use the regulator Contrast resp. Intensity.

Depth-Weight

By using the value Depth-Weight object closer to the observer can be displayed brighter than objects which are more far away. This effect is switched off when set to 0.0.

WARNING

A wrong parameter selection for the surface visualization may entail that important parts of the picture are not or insufficiently visualized. The predefined values for contrast and intensity could not suffice for the actual case so that the user must manually intervene for a visualization of important parts of the picture.

7.2 Selection of Smoothing

In the menu field Smoothing a smoothened surface display is achieved by applying a noise reduction filter. By Smoothing Off (folding list) any smoothing is excluded. This corresponds to a higher resolution and thus a more detailed surface display than with the selection of Medium or Strong smoothing. The Noise Reduction mode applies a dedicated filter on the original data – Note: This is a one way operation, in order to get the original data back you have to reload the 3D data.

WARNING

3D visualization with activated smoothing leads to a loss of detail. Important image parts like small objects may no longer be displayed.

7.3 Selection of Scaling

With the slider Scale the scaling factor for the z-dimension (direction of acquisition movement) is defined. The scaling value depends on the velocity of the acquisition.
8. 3D Color Settings

In the main menu **COLOR SETTINGS** the ScanNT system provides the display of Color-Data (Ultrasound Color-Flow, Angio-Mode, Power Doppler, etc.), as well as the definition of the color used to display grey values.

The main menu **COLOR SETTINGS** is activated by clicking on the button in the menu symbol bar.

![Figure 8-1: COLOR SETTINGS Dialog field](image)

Using the parameter **Base Color** different predefined color settings are available in order to dye the original grey level data. By using **Manual** you may define the amount for color for each color channel (RED, GREEN, BLUE):

![Figure 8-2: MANUAL COLOR DEFINITION](image)
By 3D-Mode different types of displaying color data are selected. Please note that these options are not available if no color data has been loaded or acquired. Further, the 3D-Display of color values is combined with the standard 3D capabilities of the ScanNT system, thus changing color modes may automatically affect 3D-Render parameters (and vice versa) as well.

You may choose one of the following types of 3D display:

**Off**
ScanNT does not display color values – neither in 3D nor in slice mode.

**First Hit**
Direct display of color values if they are located in front of b-mode data.

**Cloudy**
Semitransparent view of color and b-mode data within one image. Color values will overlay grey-level results and vice versa. This is the most recommended mode to display 3D color data.

**Gradient**
Calculates a colored gradient (surface) image the grey-level part is computed using semitransparent approach.

**C+B**
This mode switches the grey level part to a Gradient mode while the color is displayed in Cloudy mode.

**Color-Cut**
By using this option in all areas that contain a color value the value for the grey level is set to black.

**ATTENTION**
This is a one way operation – to undo please re-load the dataset.

**B-Mode Opacity**
By using this valuator you may change the optical weight of the b-mode part. By reducing the value of B-Mode Opacity the grey-level part become more transparent, by increasing this value the grey-level part will become stronger compared to color-flow data. Using a value of 0.0 will remove b-mode part totally.

**Color-Intensity**
By using this valuator the brightness of color-values are changed. Note: Changing intensity of color affects the impression of color data – e.g. dark red vs. light orange. The default value is 1.0.

**Color-Opacity**
Similar to the B-Mode Opacity value this valuator changes the 3D impression of Color-Flow data. Reducing Color-Opacity will set the color-values more transparent while increasing this value will set color-data more solid.

**WARNING**
3D color is the result of several calculation steps including user defined color settings and is therefore an inevitably manipulated display mode.
9. Ultrasound Acquisition

In the main menu **ACQUISITION** ultrasound sequences are acquired. After the acquisition of ultrasound (Scanning or Sampling) a three-dimensional realistic reconstruction of anatomic structures (resampling) is achieved by a combination of the two-dimensional single images.

The main menu **ACQUISITION** and a separate window **Ultrasound Image** is activated by clicking the button in the menu symbol.

![Figure 9-1: Dialog field Acquisition](image)

9.1 Acquisition of Ultrasound Sequences

In the main menu **ACQUISITION** different modes for an ultrasound acquisition, the resampling, loading, and storing of acquisition sequences are selected.

**Starting the 3D Ultrasound Acquisition**

Before starting the application needs to initialise by choosing the corresponding option from the EchoWave software. Start and stop is handled via Telemed software as well. For further details please see corresponding manuals.

---

**WARNING**

It is essential that the patient rests motionless during the ultrasound examination. A movement of patient during the acquisition may lead to heavy geometric mistakes.
9.2 Displaying the Ultrasound Sequence

After activating ScanNT Telemed Edition, the window Ultrasound Image visualizes the recorded ultrasound image sequences.

![Ultrasound Image](image)

In the function symbol bar of this window you select - besides the functions described in chapter „Basic Functions“ - the button for the reproduction of ultrasound records.

Start the reproduction of the ultrasound sequence

By a second click you stop the reproduction and call a function symbol bar with the buttons for storing as TIFF image and printing.

Using this function key the ultrasound sequence is stored as uncompressed AVI file. Please consider that the AVI file can be as large as several MB.

**Frame**

By the regulator **Frame** the actual position of a single image within a record sequence is selected. During the acquisition the single images are numbered. On the left side of the regulator the actual position (number) of the single image is shown. When the sequence is resampled the regulator moves and the number indication is continuously updated.
Display ultrasound images in pictogram mode. In this mode the software allows to edit the acquired sequence with these mouse clicks:

1. Left Mouse Button (Image Selection)
   Select an single image within the sequence.
   Together with Shift key you may select a block of images.
   Together with Control key you select more than one image.

2. Middle Mouse Button (Undo delete)
   After deleting of the selected images you may press the red arrows with the middle mouse button in order to get the removed images back.

3. Right Mouse Button (Delete images)
   After a selection has been made you may delete the images by pressing the right mouse button.
   Note: Unless you store the sequence the delete images are still available and can be returned by using the undo function or the undo button.

Undo delete operation: Get all deleted images back.
Region of Interest

In order to define which parts of the ultrasound screen will contribute to the final 3D dataset it is recommended to define a Region of Interest which is indicated by the red polygon.

When the Edit Mode is activated you can change the ROI by clicking on the edge points of the region of interest. Keep the left mouse key pressed and freely move the corners of the polygon. When clicking inside the red polygon the complete ROI can be moved.

When the button Set ROI Points is activated you can insert new points by clicking inside the ultrasound image or you may delete certain buttons by clicking with the right mouse button on the desired point. Please note: Currently it is not possible to define a concave ROI, therefore it is not possible to define new points inside the polygon nor you can move points in a concave shape.

When you quit the main menu ACQUISITION the window Ultrasound Image is also closed.

9.3 Resampling of Ultrasound Acquisition Sequences

Before starting the resampling (reconstruction of the two dimensional ultrasound records to a three dimensional image) the parameter Resolution and Sampling must be determined.

Resolution

In the menu field Resolution you choose the size of the dataset. In the pendent list you select on of the two formats offered for the dataset.

If you select the mode Static 2 MB-16 MB the original data are converted to volume sizes from 2 MB to 16 MB.

If you select the mode Dynamic 25%-100% the data are stored with a storage capacity between 25 % and 100 % of the original volume. If the storage capacity exceeds 50% the resampling process is running very slowly and you need a very large storage volume.

Hint: A static value of 8MB should be sufficient for most cases.

WARNING

A low volume resolution may lead to unsatisfactory detail resolutions.

With the slider Geometry the kind of movement during acquisition is defined. The range is between 0° (linear scan) and 90° (fan scan). Please
define this value before you start the resampling procedure – in case you want to alter your setting you may change the slider and press Resampling again.

By this button you start the three-dimensional reconstruction of the scanned anatomic proportions. This is done by combining (Resampling) the acquired single images of an ultrasound acquisition sequence to a Cartesian volume grid.

WARNING
If a three-dimensional presentation of the object is noisy - especially at the transition between the media - it is recommended to repeat the acquisition.

9.4 Loading and Storing of Image Sequences

Loading of Volume Datasets

The loading of volume datasets is described in the main menu File I/O under Load.

Storing of Volume Datasets

The acquired ultrasound sequences are resampled after you have selected one mode each under the menu fields Resolution and Sampling. The storing of volume datasets is performed under the main menu File I/O. By clicking the button Save 3D the database is activated. After selection of the register card Pictures of Examination you click the button Save. The input mask Comments is activated and you give in a name of the dataset. By clicking OK the volume dataset is stored into the database. The name of the stored volume dataset is indicated in the upper line of the list Pictures of the register card Pictures of Examination.

Loading and Storing of Single Images

By the button Import Frames the single images are imported. After clicking the button you activate the mask Open. After selection of the data you click Open.

By the button Export Frames the acquired single images are stored externally (not on the database).
By the button **Save Frames to Database** the acquired single images are stored in the database. After clicking the button the data are first written on a temporary directory (intermediate store). If you have not yet selected a patient you are asked to do this or classifying a new patient. After confirmation of this information the dataset is stored into the database.
10. Clipping

In the main menu Clipping surface and volume areas of the object are faded out in the section window and in the 3D window.

The main menu Clipping is activated by clicking the button in the menu symbol bar.

![CLIPPING](image)

**Figure 10-1: Dialog field Clipping**

10.1 Clipping of Surface and Volume Areas

**Clipping Mode**

In the menu field Clipping Mode the modes for removing areas of the object are determined.

---

**WARNING**

All options to select or to remove a region of interest may entail that important image information is no longer displayed.

For a correct interpretation of patient datasets it is important to use only those 3D displays for further processing where no areas have been removed.
This button serves to define the region of interest parallel ly to the axes by moving the polygons (red inner frames in the section windows) by means of the six regulators X-min [%], X-max [%], Y-min [%], Y-max [%], Z-min [%] and Z-max [%]. The regions outside the polygons are not displayed at the 3D object in the 3D window.

By actuating the 6 regulators X-min [%], X-max [%], Y-min [%], Y-max [%], Z-min [%], and Z-max [%] you determine the regions within the polygons. All polygons of the section window are moved within the sections on the X, Y and Z axis. The regulators X-min [%], Y-min [%] and Z-min [%] are in the basic position at 0,00 %. The regulators X-max [%], Y-max [%], and Z-max [%] are in the basic position at 1,00 %.

In the basic position of the regulators the polygons are displayed in maximum size.

In the upper section window the polygon is moved by the regulators X-min [%], X-max [%], and Z-min [%], Z-max [%] on the X and the Z axis.
In the section window bottom left the polygon is moved by the regulators Y-min [%], Y-max [%], and X-min [%], X-max [%] on the Y and the X axis.
In the section window bottom right the polygon is moved by the regulators Y-min [%], Y-max [%], and Z-min [%], Z-max [%] on the Y and the Z axis.

This button serves to define the region of interest with the mouse by changing the position of the polygon angles. Click one angle of the polygon with the left mouse key and, keeping the key pushed down; draw the angle into the desired new position.

This button serves to remove regions in the section windows and in the 3D window with the mouse. Click a certain point at the object with the left mouse key and draw a blue contour line around the region you want to remove, keeping the mouse key pushed down. After clicking with the middle mouse key into this region a rendering is automatically performed in the 3D window and the removed areas inside the contour line are marked. The marking of the removed region is continued through the whole volume of the object and is displayed as red-hatched marking in the sections of the section window and as a black marking at the 3D object in the 3D window. For this operation ScanNT uses a volume mask.

In order to undo the last „Erase operations“ click with the right mouse button inside the window.

Similar to the erase button this option allows you to define a region that should be explicitly visible on the screen. All other parts of the image are erased. To activate, click with the left mouse button into the image and encircle the desired region. After pressing the middle mouse button all
parts outside your region are deleted. To undo, press the right mouse button.

This button serves to erase isolated disturbing artifacts with the mouse in the 3D window. Click with the left mouse key to where you want to perform this operation. Every further mouse click with the middle mouse button will start to erase one step further. To undo one step, click with right mouse button. Note: The definition of the Erase Mouse Button and the ‘Undo’ mouse button could be changed during setup and therefore could be swapped on your system.

Reset Clipping
By pushing the button Reset Clipping all polygons are restored to the original maximum size.

Undo Erase
By pushing the button Undo Erase all „Erase operations“ are undone performed by the Free Erasing mode.

Hide Cut Area
As a default configuration the regions that are erased are marked red within the slice windows. In order to remove the red marking press this button.

Clip Colors
When performing the erase functions the color data inside the dataset is not affected and therefore remains visible. Under some circumstance it might be useful to remove also the color channel of the data. To enable this option press this button.

10.2 Visualization of an Oblique Cut
The buttons 2D-Cut and 3D-Cut allow the display of oblique-angled cuts on a discretionary axis in the window Oblique Cut and in the 3D window.

In case you want to display the Oblique Cut also in the 3D window we recommend switching the Illumination Mode to either Semi Transparent or Gradient Mode.
By clicking Oblique-Cut the window Oblique Cut is activated showing the oblique-angled cut.

By clicking 3D-Cut the position of the cut is shown by an oblique cut at the 3D object in the 3D window. A second click onto the field 3D-Cut deactivates the 3D window.
During operations like rotation, tilting or gliding along a discretionary axis, the modifications of the position of the cut planes are synchronously visualized in the Oblique Cut window and in the 3D window. The selected cut plane is displayed in the 3D coordinate window as a separate, white frame. Each modification of the position of the selected cut plane is visualized with a constant position of the 3D orientation image. By activating the 3D orientation image, the movement of the 3D orientation image is enabled by mouse click.

![Oblique Cut window](image)

**Figure 10-2: The Oblique Cut window**

**Changing the Oblique Cut Plane**

The Oblique Cut Plane can be defined in two different modes.

In this mode, the plane is defined via mouse action inside the output window of the Oblique Cut:

Using the left mouse button, you rotate the image around an axis that is perpendicular to the screen. Using the middle mouse button, you move the plane back and forward (by moving the mouse up and down). Finally, using the right mouse button, you rotate the plane around its center point similar to a trackball movement.

In this mode, you define the plane within the section windows:
By clicking with the left mouse button you change the center point of the Oblique Cut plane. By clicking with the middle mouse button on the “Stick” you rotate the plane around the center point and therefore changing the plane orientation.

Size

The Size regulator enables a zooming of the image section of the oblique cut by a gliding scale modification. The upper and left sides of the frame of the window Oblique Cut form an angle that has a yellow scale.
11. Video Recorder

In the main menu RECORDER video sequences (animations) of rotations of the examined object are recorded, loaded and stored.

The main menu RECORDER is activated by clicking the button in the menu symbol bar.

![Recorder Dialog](image)

Status field

In the status field notifications like number of recorded pictures, stored and removed pictures are given.

11.1 Performing Rotations

Setting the rotation options below the animation of the recorded sequence is determined.

By clicking **Object-Axis** rotations are performed around the object axis. To determine the rotation angle you use the regulator dX, dY, and dZ.

By clicking **Windows-Axis** rotations are performed around the window axis.
The regulators \( \text{dX}, \text{dY}, \text{dZ} \) on the right side of the dialog field are needed for the rotations of the object. Before starting a record you determine the rotation angle around the coordinates \( x, y, \) and \( z \) with these regulators. The size of the rotation angle is indicated on the right side of the regulator.

With \textbf{Set with Mouse} you may set the rotation origin arbitrary inside the object. This is useful in case that you may rotate around a region of interest. After selecting this button click with the left mouse button a location on the object either in the 3D window or in one of the slice windows.

With \textbf{Reset to 0.00} you cancel the mouse-set rotation origin.

\textbf{WARNING}

If the modes for the performance of rotations are not optimally set an information loss may occur, e.g. if the object twists out of the image surface of the 3D window. The preset values may not entirely cover the actual patient dataset so that the user might have to intervene manually in order to get a display of important data ranges. Also see the warning hint in the chapter „Security hints“ \(
\rightarrow \) „Optical Delusions“.

\textbf{11.2 Recording a Video Sequence}

After selecting the rotation options you may start by clicking the resp. buttons (see below) the automatic performance of the rotation steps and start the record mode. By a second clicking on these buttons you stop the record of the video sequence. By activating the \textit{Show Window} (see below) you display the video sequence.

Start the automatic actuation of the rotation steps.

Activate the record mode. Every new picture will be recorded, thus every rotation step will be stored.

Stop rotation and recording.

Erase all recorded pictures.
Save the recorded video sequence. The sequence will be either stored in an internal file-format **VID** or as an **AVI** sequence, depending on the specified file-extension when storing the file.

Load a recorded video sequence (internal format **VID** only).

Save the recorded video sequence to the database.

**11.3 Displaying Animations**

To display a recorder sequence you open the 3D-Animation Window by selecting **Show Window** and start the recorded video sequence (The window is shown below in Figure 11-2)

![3D-Animation Window](image)

*Figure 11-2: 3D-Animation Window*

Inside the animation window you may select one of the following options:

**Play Position**

After stopping the running video sequence the particular play position of a picture within a sequence is indicated in the right corner above the regulator when pushing **Play Position**. If you want to examine a particular picture (a particular position of the object), you select the desired picture number.
InViVo ScanNT Telemed Edition Video Recorder

11.4 Loading and Storing Animations

Clicking on Import Animation video sequences are imported as VID (InViVo-Video-Datatype) from an external file. By clicking Import Animation you activate the input mask Open. After selecting the desired file the video sequence is loaded.

WARNING
When an animation is loaded, check if the warning symbol is indicated. If, on selection of the warning symbol in the WARNING mask the note “Warning was active during the recording of loaded animation” the animation was recorded while probably not optimal settings were applied.

Loading of AVI datasets
The AVI dataset (Audio-Video-Interlaced; MS Windows video data type) is activated by selecting the desired data name using the Windows Explorer on the hard disk. The AVI data type is linked under Windows with an AVI player and can therefore be played immediately. A separate window is faded in visualising the animation.

Choosing Save Animations to Database the database is activated for storing video sequences. Since a video sequence has to be linked to a volume data set this option is not available if the corresponding volume is not stored in the database. The database will automatically link the sequence to the related volume data set.

Loading of Animations from Database
To load a sequence from the database you open the database via File-IO menu and double click on the desired video sequence.

Using the Button Export Animation video sequences are stored as VID (InViVo video data type) onto an external data storage medium. The sequence will be either stored in an internal file-format VID or as an AVI sequence, depending on the specified file-extension when storing the file. By clicking Export Animation you activate the input mask Save Animation as. After input of a file name you store the video sequence.

WARNING
When storing video animations in AVI file format the image quality can be reduced and information might be lost when using compressed AVI
format. Since the AVI compression is provided by third party products MedCom can not guarantee sufficient results. Furthermore, it is strongly recommend testing the AVI output after storage in order to prevent unexpected results.
12. Tools

In the main menu **TOOLS** the distribution of the grey shade values of the dataset is determined.

The main menu **TOOLS** is activated by clicking the button in the menu symbol bar.

![Tools Menu](Figure 12-1: Dialog Field Tools)

By this button the software generates some timing output.

In the mode **Histogram** the distribution of grey shade values in the actual dataset is shown. By clicking the button you activate the window **Histogram**.

**Status field**

In the status field measurements performed by using the button **Timing** are presented.

**Visualization of grey shade values**

In the window **Histogram** the distribution of the grey shade values within the dataset is graphically represented. In the upper part of the window the number of a grey shade and the quantity of the voxels of this grey shade are indicated in red. Below the relative frequency of this grey shade in percent is given.
By the button of the function symbol bar specific for the window **Histogram** and by the mouse key functions the distribution of the grey shades, similar grey shades, and grey shades of a grey shade area are visualized in the histogram and in the section image windows. More information is available in the chapter „Mouse Key Functions for the Window Histogram”.

**Figure 12-2: Window Histogram**

By the regulator **Scale** the scales of the histogram axes are changed.
12.1 Presets

After selecting the button **Presets** (or pressing key **F2**) the dialog box for selecting and editing parameter sets is displayed:

![Figure 12-3: Dialog Box Presets](image)

**OK**

To select an entry from the list you first select the group and click on the desired preset using left mouse button and press **OK**. The system immediately updates the current parameter settings according to the chosen preset.

**Preset Groups**

ScanNT allows defining several groups of presets. For each group only the corresponding presets are shown in the list.

**New**

To create a new preset group entry you press **New** and edit the name of the newly generated group entry in the re-emerging dialog box.

**Edit**

To change the name of the current group you press **Edit**. A dialog box for changing the group name appears.

**Preset Lists**

**New**

To create a new preset entry you press **New**. In this case the current program settings are stored under a new preset entry. To edit the name of the newly generated preset entry, write the name into the re-emerging dialog box.

**Rename**

To change the name of a selected entry you press **Rename**. A dialog box for changing the preset name appears.

**Delete**

To remove an selected entry from the list you press **Delete**.
Warning: Deleting an entry can not be reversed.

**Note:** Certain parameter setting may not fit to a particular data case. After selecting a preset entry it is often required to manually alter some parameters values.
13. The VPan Module

The VPan module allows the recording of image sequences in order to build a larger ultrasound overview image by combining (glueing) the single images. After selecting the VPan button within the main window, the user interface changes to the VPan mode:

![Figure 13-1: VPan Module](image)

**Note:** This module may not be included in your configuration.
13.1 The VPan Menu Bar

Within the VPan menu bar the following functionality and options are selected:

**Image Output**

In order to export an image of the VPan Window you press the *Photo* Button. In the dialog box the destination of the image is defined:

- **Printer** sends the image to a connected printer devices,
- **Database** stores the image in the database,
- **File** writes the image in JPG format directly on the file system.

Note: The **Database** option is not available if the VPan is not yet stored in the database.

**Show US Frame**

Using this option the currently selected ultrasound image (defined by the *Frame Marker* slider) is written inside the main window of VPan. You may change the position of the small ultrasound image by clicking with the left mouse button inside the area and move that small window while keeping the mouse button pressed.
Color Settings
In order to change the color appearance of the VPan image you may click on this button and select either one of the predefined options or define your preferred setting manually.

13.2 The VPan Main Menu

On the right side of the VPan module the main parameters can be selected.

Image Creation
In case you’ve change the region of interest (see below) after your image acquisition you should press this button in order to recalculate the VPan image.

VPan Recording Window
By pressing this button you open the recording window. This window displays the ultrasound sequence before applying the VPan algorithm.
This window is in particular useful to define or change the Region of Interest (ROI) that is taken to build the final VPan image.

In order to change the ROI you click on the edges and move the point. Alternatively you may click inside the rectangle and move the whole ROI. In case your ultrasound scan contains a large area with less ultrasound information (e.g. black) you should exclude this part using the ROI (like in figure 14-7).

For the further options within this window please refer to the ultrasound acquisition chapter.

**Image Zoom**
Using this slider you may change the size (zoom) of the VPan image.

**Merging Level**
Using this parameter the influence of all ultrasound images that compound to the final VPan image is modified. A value of zero means that the algorithm places the first and only the first image into a certain VPan region -- resulting in a rather sharp image appearance. By increasing this value the algorithm places and merges more images into a final VPan region – resulting in smoother images.

**Frame Marker Position**
This slider defines the “marker frame” position within the VPan image. The marker frame is optionally outlined inside the VPan window and...
displayed below the parameter options. Furthermore, this value becomes important when using the MoveSim option (see below).

**MoveSim and Frame Mark**
The option MoveSim together with the value for Frame Marker Position creates a VPan image that is computed up to this position. The effect is called Movement Simulation since it shows the image generation during the transducer movement when the position slider is move continuously. By selecting Frame Mark the current slider position is marked additionally by a green rectangle within the VPan image.

**VPan File I/O**
Using Open DB the database is activated in order to select a VPan acquisition -- to store a new acquisition in the database you press Save To DB. By selecting Import or Export you load or write a VPan file directly from and to the file system.

### 13.3 Mouse Functions within the VPan Window

Inside the VPan image some actions are defined using the mouse buttons:

a) By clicking with the left mouse button and keeping pressed you move the content inside the VPan image.

b) By clicking with the right mouse button and keeping the mouse button pressed you rotate the content inside the VPan image.

c) By clicking with left mouse button on the small Us-Frame image (see Show Us Frame above) within the VPan window you move that region.

d) By clicking with the left mouse button on the markers within the grey bar area on the left you define the contrast and intensity of the VPan image.
14. The Easy Volume Module

The Easy Volume module enables recording multiple volumes in a sequence and visualizing them in a convenient way. Once a volume or a sequence has been recorded and resampled in the Easy Volume mode, switching into ScanNT the EasyVolume appear.

![Sample Easy Volume view](image)

Figure 15-1 Sample Easy Volume view

For manual switch between layouts press the button on the top toolbar.

14.1 The Easy Volume Menu Bar

In the Easy Volume layout there are two buttons on the top menu bar. Both of them refer to database functions.

Database button enables switching between ScanNT and Database view. It has the same function as “open patient database” in the File I/O dialog in the normal ScanNT layout (please see section 6.1.).

Pressing save to database button invokes saving acquired volume (or a volume sequence) in to the database. It has same functionality as the “save 3d to database” button in the File I/O dialog in the standard ScanNT layout section. Please note that after saving the dataset into the database
and switching back to Telemed, acquired volume is deleted from the RAM memory and place for new acquisitions in the Easy Volume mode is prepared.

14.2 The Easy Volume Main Menu

The main menu of the Easy Volume Menu contains 4 sections: orientation, 3D settings, clipping and video. All of them deliver most used options for recording of multiple 3D datasets and volume visualizations. User interaction is reduced to the minimum. However, if some elaborate settings are needed, one can adjust them in the standard ScanNT layout.

Pressing the “enable” button, user can adjust volume orientation setting eye point, view and distal (feet) direction. In the orientation setting mode, slice windows look as follows.
The 3 points refer to above mentioned entities: eye point, view point, distal direction. They can be moved with the mouse in the same way as the slice marker (please see section 5.2.). The 3 points can have 2 colours: yellow and blue. If a given point lies on the selected slice, it is yellow, otherwise it is blue. Pressing a mouse button alters the position of the closest point to the mouse pointer. Moving a point brings it always on the actually selected slice. Pressing the “enable” button again, updates the actual orientation of all recorded volumes according to adjusted settings. Any new acquired volume will have initially the same orientation. Below, there are some examples of 3 points configuration and their outcome on the volume orientation.

Figure 15-4 Orientation setting in the left – right or right left acquisition. Bottom left window shows the apex plane.
Enabling the flip mode, makes every second acquired volume flipped along direction perpendicular to the probe plane. This allows sequential ultrasound scans without loosing contact between patient’s body and the probe. So making a bottom-top and then top-bottom scan will result in two volumes with correct orientation set. The same applies to left-right and right-left sequence.

Next section in the Easy Volume menu is responsible for setting visualizations parameters. It has the most used subset of 3D settings of the standard ScanNT layout.

The mean slider controls the transfer function between opaque and non opaque intensity range. For further details see 7.2.

The next slider is responsible for the intensity of the rendered volume.

With the slider Scale the scaling factor for the z-dimension (direction of acquisition movement) is defined. The scaling value depends on the velocity of the acquisition.

**Note:** This parameter applies to each volume separately.

User can choose between two preset 3d rendering opacity tolerance values (please refer to 7.2). Soft is equal to setting the tolerance to 255 and sharp to 150.

Clipping subsection buttons have the same functionality as those in the clipping menu in the standard layout.
Pressing the reset button, all clipping and erasing settings are reset.

This button serves to define the region of interest with the mouse by changing the position of the polygon angles. Click one angle of the polygon with the left mouse key and, keeping the key pushed down; draw the angle into the desired new position.

This button serves to remove regions in the section windows and in the 3D window with the mouse. Click a certain point at the object with the left mouse key and draw a blue contour line around the region you want to remove, keeping the mouse key pushed down. After clicking with the middle mouse key into this region a rendering is automatically performed in the 3D window and the removed areas inside the contour line are marked. The marking of the removed region is continued through the whole volume of the object and is displayed as red-hatched marking in the sections of the section window and as a black marking at the 3D object in the 3D window. For this operation ScanNT uses a volume mask. In order to undo the last „Erase operations“ click with the right mouse button inside the window.

Similar to the erase button this option allows you to define a region that should be explicitly visible on the screen. All other parts of the image are erased. To activate, click with the left mouse button into the image and encircle the desired region. After pressing the middle mouse button all parts outside your region are deleted. To undo, press the right mouse button.

**Note:** clipping settings apply to the all volumes from a recorded sequence.

Lowest part of the menu deals with managing the volume sequence.

Pressing the thrash bin button the actual volume is deleted

The play button displays the recorded sequence in a loop. Pressing the button again stops the display loop.

The actual volume can be selected moving the volume slider.

This slider controls the speed of the display loop.
Within the Easy Volume module, the user has the possibility to generate some predefined movies and save them to different destinations. For detailed descriptions on how to handle ScanNT animations, please refer to section 11 (video recorder).

The 3D movie button generates an animation with the actual volume rotating from -45 to 45 degrees along the screen Y axis.

Having recorded a volume sequence and pressing the 4d movie button, one can generate an animation containing a loop over all acquired dataset.

Last recorded video sequence can be saved either to the database or file.

For detailed information on saving video sequences (i.e. choosing format) please see section 11 (video recorder).

WARNING
The Easy Volume module provides only a 3D visual impression of scanned objects. It is not intended to be used for diagnostic purposes!
15. Version

In the main menu **VERSION** you find the address of the supplier of ScanNT *Telemed Edition*.

Clicking the button in the menu activates the main menu.

An INFO field **About InViVo ScanNT Telemed Edition** is faded in. You get information about the supplier and the version of ScanNT *Telemed Edition*.

By clicking **Close** you close the INFO field.
16. Database Application Notes

In this chapter we describe step by step some procedures which may be needed when using the database Client.

In this description an arrow:

👉

means a normal step in the procedure and a dashed arrow:

👉

means an optional or alternative step.

16.1 How do I create a new patient?

If you are not in the database surface, press Open Patient Database in the File I/O menu.

In the database surface choose the new patient button or choose Add -> Patient from the main menu or press the right mouse button over the patient tree and select New from the appearing pop up menu.

👉

Enter the properties of the new patient in the New Patient dialog and press OK.
16.2 How do I create a new user for the database?

Move to the database surface with **Open Patient Database** from the **File I/O menu.**

Choose **Administration -> User Manager** from the main menu.

The **User Manager** appears.
Press the **New** button in the upper right corner of the User Manager.

In the appearing **New Doctor** dialog enter the properties for the new doctor and press **OK**.
Note: In this way you can create both: users for the Client program and for tele-versions also recipients of your messages. If you want to create a user please mark the checkbox **Access to the database** and enter the properties of the **Database Access** area, for the phonebook entry select **none**. Otherwise don’t fill the fields in the **Database Access** area but select a phonebook entry. In this case you first have to create a phonebook entry (see chapter 4.5), before you can create a new doctor.

### 16.3 How do I swap out data?

If you store large amounts of data, sooner or later you will have the problem that your hard disc will be full. Then you need to move parts of your database to external media. We have implemented the possibility to move studies and patients to magneto optical disc, other hard disc directories and network drives. We recommend swapping out only data, which is not expected to be updated anymore. Anyway, if you have moved a study to external media and you want to use it again, you can move it back to the hard disc (see chapter 9.4).
We strongly recommend implementing a backup mechanism for your hard disc. Swapping out data is no alternative for backing up your hard disc.

If you want to move parts of your database to an external media follow the steps described below:

Generally, if you want to swap out data, you need to be logged in a local database. If you use a Client/Server version of the database, you must start the database interface on the server PC to swap out or move back data. If you want to move more than one study or choose patient **File -> Swap Out Data** or the **Swap out data** – button.

Then a dialog will be opened, where you can choose the age of the data you want to swap out, the maximal amount of data to swap out and the location to which you want to store the data. Locations for swapping out can be defined under **Administration->Drives**.

If you want to swap out the whole data check **Move all data**. Normally you will move only the data of a specified age. For example all studies, which have not been changed the last 6 months.

After you press OK the swap out process will begin.
If you only want to move a single study or patient, to start the swap process do the following instead of the steps described above:

With the right mouse button select **Swap out** from the **Patient Pop-Up** menu or the **Study Pop-Up** menu.

Again the swap out process will be started.

After you have started the swap out process in one of the ways described above, a window appears which shows you the size of the data you want to move and asks you to confirm the swap out decision.

Press **OK** to confirm the swap out decision.
If you are swapping out to MO the system is searching for a MO in the drive which you have specified. If you haven’t inserted an MO the system asks you to insert one.

If you first use an MO please insert an unlabeled and unformatted MO. Then the program automatically formats and labels the MO and asks you to write the ID on the MO.

Please use only MO’s formatted and labeled from the Client and use them exclusively to store data from this program.

If you once have stored data on an MO you can reuse it as often as you want, until it is full.

If you have entered a labeled MO the program begins to move the data.

Don’t move the MO out of the drive until this process has finished.

If you want to move larger amounts of data, we recommend to do this over night or at the weekend, because it could take some time. If the program is ready you will see the message below.

Now the swap out process is finished.

Though you can load files directly from magneto optical disc, if you want to use a study again, we recommend to move it back to the harddisc. To do this follow the steps described in the next chapter.

16.4 How do I move back a study to the main directory?

Generally to move back data you need to be logged on to the local database. If you are storing your data centrally on a server please start the
database interface on the server. You can only move back a single study to the hard disc.

Press the right mouse button over a study and select **Move back to hard disc** from the **Study Pop-Up** menu.

If the data is stored on an MO the system will search for a MO and ask you to insert the MO on which the study is stored.

If you have inserted the wrong MO the system will ask you to insert the right one.

If the right MO is in the drive or if the study is on an hard disc or network drive the program will move the study back to the hard disc and inform you when it is ready.

Now you can load the files of the study from the main directory again.

**16.5 How do I import and export data?**

In some cases it could be possible that you are using two databases on two different PC's without a network connection between them. If you want to move files from one database to another you need to use the import/export-function of the **Client**. Then you first need to export the data you want to transfer and store it on a media like CD-Rom or floppy disc. Then put the media into the other PC and import the data from there. To do this, perform the following steps:
If you want to export a single file, select Export from the File-Pop-Up menu over the file.

If you want to export a study, select Export to file from the Study Pop-Up menu over the study.

If you want to export a patient, select Export to file from the Patient Pop-Up menu over the patient.

Now the Export dialog appears which shows you the name of the patient, the name of the study and the treating physician which belongs to the data you want to export. If you want to export the patient as an anonymous, mark the Anonymous checkbox.
Press OK to select a directory and a filename for your export file.

Enter a filename in the appearing file dialog. The file will be stored with the extension .mcd after you have pressed Open.

To import the data out of an .mcd – file do the following:
Select File -> Data Import.
Select the file with the data you want to import in the appearing dialog and press **Open**.

The file import dialog appears, which shows some information about the data you want to import. Press **OK** to perform the import.
Now the import will be performed and the patient will appear in the patient tree. Thereby the system checks if a patient with the same ID or name and birthday or a file already exists in the database to avoid double storage of data.

16.6 How do I acquire frames and store in the database?

Refer to the corresponding ScanNT chapter for how to acquire an ultrasound sequence. For storage of a new sequence in the database do the following:

From the File I/O menu choose **Save Frames to Database**.

Now the frames will be stored in a temporary file and the **Select Patient-Study** dialog appears. Select a patient and a study from the appearing patient tree.

If you want to create a new patient press the **New Patient** button. Enter the properties of the new patient in the **New Patient** dialog and press **OK**.
If you want to create a new study for an existing patient select the patient in the tree and press **New Study**.

Enter the description for the study in the appearing dialog and press **OK**. For a new patient you always need to create also a new study.
If you have finished with the creation of study and patient select the study to which you want to assign the frames in the tree and press Next>>.

Enter a comment to the file and press OK.

Now the frames will be stored in the database. In order to store new volume datasets (i.e. after resampling) please perform the same steps.
17. Fault Tracing

<table>
<thead>
<tr>
<th>Fault</th>
<th>Possible cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Faulty, unfamiliar image quality</td>
<td>Defective ultrasound device</td>
<td>Inform service, stop work</td>
</tr>
</tbody>
</table>
| No storing of the data under **Save Examination Data** | • Database defective  
• Initialized files of the database destroyed  
• Drive defective | Inform service, stop work |
| No link to database                |                                    | Inform service                  |

17.1 Fault examples

**Faulty acquisitions:** Left: correct record, Right: disturbances caused by a jerky probe movement.
18. System Requirements

The InViVo ScanNT Telemed Edition is software for the acquisition and visualisation of 3D ultrasound data. The complete system is assembled by a software part and hardware devices. The customer is responsible that the hardware part and additional software part fulfils the requirements summarised in this document in order to achieve CE conformity.

18.1 Software Requirements

Operating System: Windows Windows XP, Windows 7, Windows 8
Additional Software: Telemed’s EchoWave software for ultrasound image acquisition.

18.2 Hardware Requirements

18.2.1 Minimum configuration

- CPU Speed: 1000MHz
- RAM Memory: 256 MB (384MB for the EasyVolume module)
- Disk Space: 100 MB free
- Graphics: 1024x768 with true color mode with a compatible display
- Interfaces: USB 2.0, standard PC keyboard and a 2-button mouse
- Ultrasound Device: Telemed’s EchoBlaster 128 product family

18.2.2 Preferred configuration

- CPU Speed: 2000MHz
- RAM Memory: more than 512 MB
- Disk Space: 500 MB free
- Graphics: 1024x768 with true color mode with a compatible display
- Interfaces: USB 2.0, standard PC keyboard and a 3-button mouse
- Ultrasound Device: Telemed’s EchoBlaster 128 product family